
 

 

In this tutorial you will learn how to use Microsoft Outlook 
with your EmailHosting.com account. You will learn how to 
setup an IMAP account, and also how to move your emails 
and contacts to EmailHosting.com.  

USING MS OUTLOOK 

 

Microsoft Outlook 

 

Microsoft Outlook is one of the most popular and by far 

the most mature email client. It offers a slew of options 

and features that will appeal to most EmailHosting.com 

users. Outlook also aptly serves as a personal 

information manager with calendar and address book 

features. You will find more information about Microsoft Outlook on its product page 

at the following link: 

 

http://www.microsoft.com/outlook

 

For this tutorial, we will consider Outlook 2003, which is the latest version of 

Outlook. If you are using a different version of MS Outlook than this tutorial, it 

should closely resemble the same options and settings. In this tutorial we will learn 

how to: 

 

 Configure the Outlook Client for use with EmailHosting.com via IMAP 

 Sending Emails 

 Receiving Emails 

 Deleting Emails 

 Backing your Emails using Outlook 

 Exporting your Emails to EmailHosting.com folders 

 Exporting your Contacts to EmailHosting.com folders 

 Importing your Contacts to Outlook 
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Configuring Outlook for use with EmailHosting.com 

(IMAP) 

 

WHAT IS IMAP? 

 

IMAP is a protocol for retrieving email messages. It is similar to POP3 but supports 

additional features. IMAP allows a 2-way communication with your email client and 

the EmailHosting.com servers. Using IMAP, an email client program can not only 

retrieve email but can also manipulate messages stored on the server without having 

to actually retrieve the messages. And so, messages can be deleted, they can have 

their status changed, multiple mailboxes can be managed, etc. 

 
CONFIGURING OUTLOOK 

 
Before you start 

You will require some details from when you set up your EmailHosting.com account. 

 

You will need the following information:  

 

The IMAP Server Name - imap.emailhosting.com 

The SMTP Server Name - smtp.emailhosting.com 

 

Your EmailHosting.com Username - (for the purposes of this tutorial we will use 

demo) 

 

Your EmailHosting.com Password - (for the purposes of this tutorial we will use 

demo) 

1. Open Outlook 2003 and from the top menu, select Tools, then Email 

Accounts... 
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2. Select Add a new email account and click Next > 
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       3. Select IMAP and click Next > 

 

Your Name: Type your name here - this will be the name emails appear to come 

from (in this tutorial we will use John Smith) 
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E-mail address: Type in your email address - this will be the address that emails 

appear to come from (in this tutorial we will use demo@emailhosting.com). 

  

Incoming mail server (IMAP): this tells Outlook where your emails are stored. 

Type in imap.emailhosting.com 

 

Incoming mail server (IMAP): this tells Outlook how to send your outgoing email. 

Type in smtp.emailhosting.com 

 

User Name: type in your user name - the part before the @emailhosting. (in this 

tutorial we will use demo) 

 

Password: type in your password. 
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4. Click on the More Settings button. 

 

 

5. Click on the Outgoing Server tab. 

6. Check the box My outgoing server (SMTP) requires authentication 

7. Select Use the same settings as my incoming server - this allows 

EmailHosting.com servers to confirm your identity for sending mail. 

8. Click OK 

9. Click Next > 
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10. Click Finish to complete the wizard. 

At this point, if you have entered everything correctly, Outlook should connect to 

EmailHosting.com and download any messages you have. 

You will see a new folder within your folder view: 
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Sending Emails 

 

To send new emails within Outlook: 

 

1. Click on the New icon from the Toolbar or use the shortcut Ctrl + N.  

 

 

 

This wi : address, 

Subject and email message,  

2. Click on the Account menu from the toolbar, and select your 

EmailHosting.com account. 

ll bring up the compose email window and after typing in your To

 

3. Finally, click on the Send button or Ctrl + Enter to send your email. 

Sending with a From: address different from EmailHosting.com 

If you have your domain name or other emails account setup ith EmailHosting.com, 

you mi

Outlook doesn’t support identities. One way to work around this is explained below: 

1. When composing a new email, click on View -> From Field.  

w

ght want to send email with those From: email addresses. Unfortunately, 

2. Enter your desired From: email address in that field. 
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SAVING YOUR SENT-EMAILS TO YOUR ACCOUNT 

By default, Outlook will save your sent-emails to its default Sent Items folder. If 

you want to have all your sent emails saved to your EmailHosting.com Sent 

Items folder instead, follow the steps below: 

1. Open Outlook 2003  

2. Select Tools | Rules and Alerts... from the menu. This leads to: 
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3. Click on New Rule... 

 

 

4. Select Start from a blank rule  

5. Highlight Check messages after sending  

6. Next 
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7. Click on Next and you

 

 should see this dialog 

 

8. Click on Yes 

 

 

 

9. Select move a copy to the specified folder in the Step1: pane  

10. In the Step2: pane click on the word specified 
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11. Scroll down, expand imap.emailhosting.com folder and select sent-mail  

12. Click on OK 

 

 

13. Click on Next 

 

 

14.  Step1: Specifiy a name for this ru  Name the rule "Sent Mail"  le.
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Click o Finish 

 

n 

 

 

15. Click on OK  
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Receiving Email 

CHECKING EMAIL 

To check your email, simply click on the ‘Send/Receive’ button from the toolbar. 

Outlook will check for new emails in your subscribed folders. 

 

DOWNLOADING EMAIL HEADERS 

By default, Outlook is set to download your email headers only. This involves 

downloading a list of subject lines of all emails in your IMAP account. To read an 

email, simply click on the subject line, and wait for a few seconds for Outlook to 

retrieve the email from the EmailHosting.com server.  

DOWNLOADING SOME ITEMS IN A FOLDER 

After you have downloaded the headers, you can mark items to be downloaded from 

the server. When you download messages, they are placed only on your computer. 

When you delete messages, they are removed from both your computer and the 

1. In your Inbox, right-click the header, and then click Mark to Download 

tcut menu.  

server. 

Message(s) on the shor

 

 

2. Click on the Send/Receive button to download the selected items. 
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DOWNL IN A FOLDER  

tlook to download complete emails including their attachment 

from the EmailHosting.com server.  

nd/Receive Settings, 

and then click Define Send/Receive Groups. 

OADING ALL ITEMS 

You can configure Ou

1. On the Tools menu, point to Send/Receive, point to Se

 

2. Click a group that contains your EmailHosting.com IMAP account, and th

click Edit. 

en 

 

 

3. Under Accounts, click your IMAP account. 

 

In the list, select the check box for each fo er you want to include when checking 

email, and then select ‘Download complete item including attachments’. 

ld
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Deleting Emails 

 

When you delete an item in IMAP mode, the message is marked for deletion by 

Outlook. It indicates this by drawing a line through the message. Outlook will not 

actu

 

ally delete the message from the server until you tell it to.  

 

To remove deleted items from the server so that they will no longer appear or count 

towards your email quota, open the Edit menu and select Purge Deleted Messages. 
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Ba ail 

 

o backup your email on your local computer, you can one of many features of 

Select the message you want to backup. You can select multiple messages by 

pressing the CTRL key. Simply drag and drop the message(s) to the folder you want 

to backup the email(s). Make sure that the folder you have chosen is on  local mail 

METHOD II – Copy folder to… 

 

If you want to backup a whole folder, you can simply select the folder, and right-click 

it. From the context menu, select Copy ‘FolderName’ (where FolderName is the name 

of the folder you have selected.)   

cking up your Em

T

Outlook. Below are a few of the methods: 

 

METHOD I: Drag-and-Drop 

 

 a

folder.   

 

 

 

This will bring up a pop-window asking you the location where you want to paste that 

folder. Select your location by clicking on the destination folder, and finally clicking 

on the OK button. 
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METHO

d be to set up a mail rule that copies all 

would use the Outlook Rule Wizard to do 

le for all messages, and the action would be to "move 

" to a local folder. 

lick on Tools/Rules Wizard. 

 Make sure the correct mail account is selected in the "Apply changes to this 

 Click "New". 

 Click Next. 

 On the "Which conditions.." page, do not click any conditions, just click Next. 

 You may be prompted that "This rule will be applied to every message you 

receive". Click Yes. 

 On the "What do you want to do with this message?" page, check "move a 

copy to the specified folder" (do not use "move it to the specified folder". 

 In the rule description box below the list of possible actions, click on the blue 

text "specified" and choose a local folder. This is where copies of your mail 

n the exceptions page, unless you want some of your messages 

you can add conditions on this page. 

Messages" perhaps. 

already in "Inbox", and click Finish.  

acking up of your messages should now be setup. 

D III: Using Mail Rule 

 

While the above outlined methods are straightforward, they may become tedious 

after some time. Another way to do this woul

messages to your local folders as well. You 

this. You would setup a mail ru

a copy

 

If you're not familiar with how to do this, here are the steps that you should follow: 

 

 C

folder" drop down menu. 

 Choose the "Start from a blank rule" radio button. 

 "Check messages when they arrive" should be highlighted by default. If not, 

click on it. 

will go. 

 Click Next. 

 Click Next o

to not be copied. In that case, 

 Type a name for the rule, "Backup 

 Check "Run this rule on messages 

 

B
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Export your Contacts to EmailHosting.com 

 

export, and drag and drop it to the 

mailHosting.com IMAP folder tree as show in the example below: 

 

Step 1: Exporting Contacts from Outlook 

To export/upload your existing email folders to your EmailHosting.com account, 

simply select the folder you wish to 

E

 

 

 

An p

disapp  be 

acc s

 

u load progress window will popup and once upload is completed, it will 

ear. Your folder will then be uploaded with all of its emails. It will also

es ible via your EmailHosting.com Webmail interface. 
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Export your Contacts to EmailHosting.com 

 

 your email client. EmailHosting.com 

cepts this data in CSV (Comma Delimited format). The following are step-by-step 

1. Click on File, go to Import and Export  

You may now export your address book from

ac

directions for exporting this CSV file from Outlook:  

 

 

 

 

2. Select Export to a file and click Next  
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  Next  Select Comma Separated Values (Windows) and click3.

 

 

4. You should now select the Contacts type folder (Address Book Folder) to 

export and click Next  
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5. You will now want to click on Browse and select a location to save your CSV 

file on your PC.  

 

 

 

6. After clicking Next you will see a screen to confirm an Export of your Contacts 

folder, simply click on Finish. 
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Ste

 

We will now upload the contact file we just exported to EmailHosting.com. To do so, 

login to your EmailHosting.com account. 

 

1. Using the Navigation Bar, Click on Contacts 

p 2: Importing the Contacts to EmailHosting.com 

 

 

2. To the right is a picture of the EmailHosting.com 

Settings Bar which lists the different pages of 

setting options you can change. On the Settings 

Bar, click Import / Export Wizard. 

 

3. This will open up the first step page of the wizard as shown below  

 

:

 

Select Import/Export: Select Import from email client. 

Select Contact Folder: Choose the contact folder to which you want to have 

your contacts imported to. 

Select email client: Choose Microsoft Outlook from the list. 
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4. Click on the Go to Step 2 button to go to the next screen. 

 

 

5. Click on the Browse... button to locate the file where you stored the .CSV file 

you previously exported from Outlook. Click on the Go to Step 3 button. 

 

 

 

ur contact 

items to be overwritten or inserted as new records. Click on the Do Import 

Now button when you are done. You should get a congratulations message 

as shown below: 

 

6. Choose the action to be performed. You can either select to have yo
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Import your Contacts to Outlook 

 
EmailHosting.com allows you to export your contacts to your email client. To import 

your EmailHosting.com contacts to Outlook, follow the steps below: 

 

Step 1: Exporting the Contacts 

 

1. Using the Navigation Bar, Click on Contacts 

 

 

2. To the right is a picture of the EmailHosting.com 

Settings Bar which lists the different pages of 

setting options you can change. On the Settings 

 

3. 

 

Bar, click Import / Export Wizard. 

This will open up the first step page of the wizard as shown below: 

 

Select Import/Export: Select Export to email client 

Select Contact Folder: Choose the contact folder you which to Export. 

Select email client: Choose Microsoft Outlook from the list. 
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4. C his will be followed by a prompt 

asking you to save the .CSV file of your contact folder. 

lick on Go to Step 2 when you are done.  T

 

 

. Click on the Save button to save the file.  

 

Step 2

 

1. Click on File, go to Import and Export  

5

 

: Importing your Contacts to Outlook 
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2. Select Import from another program or file and click Next  

 

 

) and click on Next. 

 

3. Select Comma Separated Values (Windows
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4. Click on the Browse… button and select the file you saved from 

EmailHosting.com. Click on Next.  

 

 

 

5. You should now select the Contacts type folder (Address Book Folder) to 

export and click Next  

 

 

6. Click on the Finish button on the next screen to begin the import. 
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